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    Chapter 11   

 Lineage Tracing in the Mammary Gland Using Cre/lox 
Technology and Fluorescent Reporter Alleles 

           Renée     van     Amerongen    

    Abstract 

   Lineage tracing using Cre/lox technology has become a well-established technique to study the contribution 
of different (stem) cell populations to organ development and function. When used in the mammary 
gland, it forms a valuable addition to the already existing experimental toolbox and an important alterna-
tive to other readouts measuring stem cell potential, such as the fat pad transplantation assay. 

 Here I describe how to set up and analyze an in vivo lineage tracing experiment using tamoxifen- 
inducible Cre/lox technology, highlighting the specifi c challenges that the investigator faces when employ-
ing this method and interpreting the results in the mammary gland.  

  Key words     Lineage tracing  ,   Mammary gland stem cells  ,   Tamoxifen  ,   Whole mount  ,   Confocal 
microscopy  

1      Introduction 

 Owing to its unique developmental properties, the mouse mammary 
gland is an excellent model system to study various biological pro-
cesses associated with tissue growth and regeneration. Located 
immediately below the skin and well outside the body cavity, it 
offers easy access. Moreover, it is a non-essential organ, thus allow-
ing relatively straightforward experimental manipulation. More 
important than these practical considerations, however, are its 
morphological and functional characteristics. Biologically speak-
ing, the mammary gland is a very dynamic tissue that undergoes 
dramatic changes in cell proliferation and differentiation during 
the life span of an organism [ 1 ]. 

 The adult mouse mammary gland is composed of a bilayered, 
ductal epithelium that lies embedded in the stromal tissue of the fat 
pad (Fig.  1 ). This elaborate ductal network forms during puberty, 
when rapid branching morphogenesis causes the rudimentary 
mammary epithelium to grow out and invade the entire length of 
the fat pad. During pregnancy, a second wave of tissue expansion 

r.vanamerongen@uva.nl



188

occurs, this time associated with the formation and terminal 
differentiation of milk-producing alveoli. After lactation, these 
alveolar structures regress in a process called involution, when 
massive tissue remodeling takes place and the gland is essentially 
restored to a pre-pregnancy state.  

 Both developmental and cancer biologists have long been fas-
cinated by these dynamic growth properties and in particular by 
the identity of the underlying stem and progenitor cell popula-
tions. As a result, a wide variety of experimental techniques exist to 
probe mammary cell behavior and function [ 2 ]. These include the 
prospective isolation of distinct cell populations based on the com-
binatorial expression of defi ned cell-surface markers by fl uorescence- 
activated cell sorting (FACS) [ 3 ,  4 ] and their subsequent 
transplantation into the cleared fat pad [ 5 ]. First devised in the late 
1950s, this transplantation assay remains a robust and powerful 
method to test the regenerative capacity of putative stem cell pop-
ulations. However, it is important to realize that it requires cells to 
be taken out of their natural environment. In contrast, dedicated 
in vivo lineage tracing studies are designed to track cell fate in situ. 
Importantly, a direct comparison of the two experimental 
approaches has revealed important differences between the normal 
developmental potential tested by lineage tracing and the regen-
erative potential displayed by the same cell population upon trans-
plantation [ 6 ,  7 ]. 

 In this chapter I provide stepwise instructions for setting up 
and analyzing an in vivo lineage tracing experiment using geneti-
cally engineered mouse models and Cre/lox technology. This 
includes breeding of the required compound genotypes, initia-
tion and duration of the trace, processing of the mammary gland 
for histological analysis, and 3D reconstruction using the Fiji 
software program. I specifi cally focus on the practical consider-
ations related to tamoxifen-inducible Cre driver lines and (multi-
color)  fl uorescent reporter alleles.  

  Fig. 1    Macroscopic and microscopic appearance of the mouse mammary gland. ( a ) Whole-mount picture of a 
carmine stained mouse mammary gland reveals a branched ductal network. ( b ) Tissue section of a hematoxylin/
eosin stained mouse mammary gland reveals how the ductal epithelium lies embedded in the stromal tissue 
of the fat pad, which consists mostly of adipocytes. ( c ) Cross section of the mouse mammary epithelium 
revealing the bilayered appearance of the epithelium following immunofl uorescent detection of basal, K14- 
positive ( red  ) and luminal, K8-positive ( blue ) cells       
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2    Materials 

   Given the amount of time and money involved with long-term, 
in vivo lineage tracing analyses, selection of the genetically engi-
neered mouse strains with which to perform the experiment is the 
most crucial step of the entire experiment. Ample time should be 
dedicated to making this decision. Ultimately the choice is up to 
the investigator, as it will depend on the specifi c research question. 
Although alternatives exist ( see   Note 1 ), the most straightforward 
and fl exible approach is to make use of the tried and tested Cre/
lox technology [ 8 ,  9 ]. 

 In this scenario, the fi rst mouse strain (hereafter referred to as 
the “Cre driver”) should express the Cre recombinase protein in the 
cell population of interest (i.e., the cell population of which 
the investigator wishes to study the developmental fate). Spatial 
control is provided by the promoter and enhancer sequences used 
to drive Cre expression ( see   Note 2 ). Modifi ed versions of the 
Cre protein (Cre ER , Cre ERT , or Cre ERT2 ,  see   Note 3 ) in addition 
offer temporal control, allowing the investigator to decide the 
onset of Cre recombinase activity and thus the developmental 
time point at which the tracing experiment is initiated. In most 
cases, this is recommended ( see   Note 4 ). The Jackson mouse 
repository offers a large selection of (inducible) Cre strains (  http://
cre.jax.org/index.html    ). Practical considerations and pitfalls 
associated with selecting the appropriate Cre driver are discussed 
elsewhere [ 10 ,  11 ]. Ultimately, however, investigators may feel 
the need to generate novel Cre driver lines, as these will be best 
suited to address their specifi c research question. This falls out of 
the scope of the current chapter. 

 The second mouse strain (hereafter referred to as the 
“reporter”) needs to meet two criteria. First, it should contain a 
conditional, Cre-inducible reporter allele that will “switch” from 
state A to state B in the presence of Cre-recombinase activity. This 
marks the cell population of interest ( see   Note 5 ). Second, after 
Cre-mediated recombination, expression of the marker gene itself 
should be driven by a constitutively active promoter, such that all 
cells in the lineage can be visualized at any given time point. 
Multiple Cre/lox technology based reporter lines are available 
from the Jackson mouse repository (  http://jaxmice.jax.org/list/
xprs_creRT1805.html    ). The simplest versions are binary OFF/
ON switches, such as the trustworthy  Rosa26-lacZ  reporter [ 12 ]. 
More sophisticated reporters, such as the  Rosa26-mTmG  line [ 13 ], 
allow cells to be visualized both before and after recombination 
by switching on the expression of a different fl uorescent protein. 
Yet other reporters, such as the  Rosa26-Confetti  line [ 14 ] are spe-
cifi cally suited for studying the clonal outgrowth of individual 
stem cells. Again, the choice of reporter will depend on the specifi c 

2.1  Compound 
Mutant Mice
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research question to be addressed ( see   Note 6 ). Some characteristics 
of the three reporter lines mentioned above, pertaining to their use 
for lineage tracing in the mammary gland, are compared in Table  1 .

   As an example, the remainder of this protocol will assume the 
presence of the following mouse strains:

    1.     Axin2-Cre   ERT2   (available from Jackson labs, stock #018867): a 
tamoxifen-inducible Axin2-Cre ERT2  allele [ 6 ] that marks Wnt/
β-catenin responsive cells based on their expression of the neg-
ative feedback target gene  Axin2 .   

   2.     Rosa26-mTmG  (available from Jackson labs, stock #007676): 
a Cre-inducible reporter allele that marks all cells in the animal 
with a membrane-bound dTomato (mT) fl uorescent protein 
prior to recombination. Cells that recombine the reporter 
allele lose mT expression and gain expression of a membrane-
bound eGFP (mG) fl uorescent protein.   

   3.     Axin2-Cre   ERT2  ; Rosa26-mTmG  double-heterozygous mice ( see  
 Note 7 ) in which the actual lineage tracing experiment is per-
formed (Fig.  2 ).       

       1.    Gloves.   
   2.    Tamoxifen solution: Dissolve tamoxifen (Sigma,  see   Note 8 ) at 

5–20 mg/ml in 90 % corn oil (Sigma) and 10 % ethanol. 
A standard stock of 10 mg/ml tamoxifen consists of 10 mg 
tamoxifen, 900 μl corn oil, and 100 μl ethanol ( see   Note 9 ).   

   3.    Corn oil control solution: Mix 900 μl corn oil and 100 μl 
ethanol.   

   4.    Nutator mixer or tube roller.   
   5.    Two 3 ml syringes.   
   6.    Two 22 μm syringe fi lters.   
   7.    Two 1.5 ml or 2 ml eppendorf tubes.   
   8.    Two 1 ml BD™ slip-tip syringes with 26 G × 5/8 in. subQ 

needles.      

       1.    Euthanasia chamber.   
   2.    Dissection pad.   
   3.    Spray bottle with 70 % ethanol.   
   4.    6–8 Pushpins.   
   5.    One pair of surgical scissors.   
   6.    One eppendorf tube.   
   7.    One pair of Dumont No. 5 forceps.   
   8.    Two pairs of fi ne (Iris or Graefe) forceps.   
   9.    Four pieces of 3 mm Whatman paper, 4 cm × 1 cm each.   

2.2  Inducing 
Tamoxifen- Mediated 
Recombination

2.3  Harvesting 
the Mammary Glands
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   10.    Glass vial with 10 % neutral buffered formalin 
(4 % paraformaldehyde).   

   11.    Aluminum foil.      

       1.    Nutator mixer or tube roller.   
   2.    Phosphate buffered saline (PBS) solution.   
   3.    30 % Ethanol: 30 ml ethanol in 70 ml PBS.   
   4.    50 % Ethanol: 50 ml ethanol in 50 ml PBS.   
   5.    70 % Ethanol: 70 ml ethanol in 30 ml deionized H 2 O.   
   6.    100 % Ethanol.   

2.4  Whole-Mount 
Confocal Analysis 
of Fluorescent 
Reporter Alleles

Cre-ERT2

mT mGSTOP

Cre-ERT2

mG
Rosa26

Axin2

Rosa26

Axin2

Cre-ERT2Axin2

+ tamoxifen

Cre-ERT2

mT mGSTOP
Rosa26

Axin2

mT mGSTOP
Rosa26

Axin2CreERT2 driver Rosa26-mTmG reporter

X

Axin2CreERT2;Rosa26-mTmG double heterozygous mouse

in Wnt-unresponsive cells in Wnt-responsive cells

  Fig. 2    Lineage tracing with the  Axin2-Cre    ERT2   driver and the  Rosa26-mTmG  reporter. Schematic depicting the 
genetic principle behind Cre/lox-mediated lineage tracing. After crossing  Axin2-Cre   ERT2   and  Rosa26-mTmG  
mice ( top ), double-heterozygous offspring will express the Cre recombinase in all Axin2-positive, Wnt/β-
catenin responsive cells ( middle ). However, owing to the presence of an ERT2 moiety, the Cre recombinase will 
be inactive. Therefore, prior to tamoxifen administration, all cells in the animal will be  red , due to expression of 
a membrane-bound dTomato, which is expressed from the  Rosa26  reporter allele. The administration of 
tamoxifen will result in a pulse of Cre-activity in Axin2-positive, Wnt/β-catenin responsive cells, which in turn 
will recombine the  Rosa26-mTmG  reporter allele. This results in a switch from membrane-bound dTomato to 
membrane- bound GFP expression in Wnt-responsive cells, but not in Wnt-unresponsive cells ( bottom ). Because 
the switch is genetic, it is permanent and will remain present for the remainder of the life span of the recom-
bined cell. In addition, it will be passed on to the cell’s offspring, allowing its lineage to be traced       
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   7.    Glass vial with methylsalicylate ( see   Note 10 ).   
   8.    Single concave microscope slide (14 mm diameter).   
   9.    #1.5 Coverslip.   
   10.    Nail polish.   
   11.    Confocal microscope with 488 nm and 561 nm laser lines for 

 Rosa26-mTmG  or with 458 nm, 488 nm, 514 nm, and 561 nm 
laser lines for  Rosa26-Confetti  ( see   Note 11 ).   

   12.    Acetone.   
   13.    Kleenex tissues.   
   14.    Glass vial with paraffi n.   
   15.    Paraffi n for refreshing.   
   16.    Hybridization oven.   
   17.    Embedding cassette.   
   18.    Computer with Fiji software (downloadable from   http://fi ji.

sc/Fiji    ).       

3    Methods 

       1.    Design the appropriate lineage-tracing experiment (Fig.  3 ).    
   2.    Breed  Axin2-Cre   ERT2  ; Rosa26-mTmG  double-heterozygous 

mice, which carry both the Cre-driver and the reporter allele, 
by intercrossing the  Axin2-Cre   ERT2   and the  Rosa26-mTmG  
strains. I usually cross a heterozygous  Axin2-Cre   ERT2   male to a 
homozygous  Rosa26-mTmG  female. Half of the offspring will 
be double-heterozygous ( see   Note 12 ).   

   3.    Genotype the mice by PCR ( see   Notes 13 – 15 ).   
   4.    Divide the mice into experimental cohorts ( see   Notes 16 – 19 ).   
   5.    Prepare the tamoxifen and the corn oil control solution. It is 

best to always prepare these fresh. Remember to wear gloves 
when handling tamoxifen!   

   6.    Incubate the solution on a nutator or tube roller. Tamoxifen 
will take some time to dissolve.   

   7.    Filter the solutions through a 22 μm syringe fi lter into an 
eppendorf tube ( see   Note 20 ).   

   8.    When you are ready to inject the mice, fi ll a 1 ml syringe attached 
to a subQ needle with each of the solutions ( see   Note 21 ).   

   9.    Remove all air bubbles by holding the syringe vertically, pull-
ing down on the plunger and fl icking the syringe with your 
fi ngers to force the air to the top.   

   10.    Insert the plunger to let all air escape.   
   11.    Put down the syringe and open the mouse cage.   

3.1  Inducing 
Cre-Mediated 
Recombination

Lineage Tracing in the Mammary Gland
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   12.    Holding it by the tail, lift the mouse that is to be injected out 
of the cage.   

   13.    Lower the mouse onto the wire rack of a cage lid and let it grab 
hold of the bars.   

   14.    With the thumb and index fi nger of your other hand, fi rmly 
grab the loose skin at the back of its neck and pull back to 
secure its head.   

labela

b

c

t0

analyze

t1

experimental timeline

trace time

developmental age

E14.5

t0

P56

t1

experimental timeline

P0

P56

t0

mid-first pregnancy

t1

experimental timeline

P0 P63

  Fig. 3    Experimental setup of an in vivo lineage tracing experiment. ( a ) Timeline 
depicting the two critical time points of a lineage tracing experiment. Using an 
inducible system, Cre-mediated recombination can occur at any time of choice. 
The time point at which the cells are labeled following tamoxifen administration 
(t 0 ) represents the onset of the actual tracing experiment. The trace can be 
stopped for analysis at any time point greater than 24 h (the minimum amount of 
time for reporter activity to be detectable) after tamoxifen administration (t 1 ). ( b ) 
The trace can be started prior to birth by administering tamoxifen to pregnant 
mothers. As an example, recombination can be induced in E14.5 embryos, after 
which the mice are traced through puberty and analyzed as adults at 8 weeks 
(56 days, P56) of age. ( c ) Alternatively, the trace can start at any time after birth. 
As an example, recombination can be induced at P56, after which the cells are 
analyzed at mid-pregnancy       
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   15.    Turn the mouse over and secure its tail between your fourth 
fi nger or pinky and the palm of your hand. Slightly tilt your 
hand, such that the head of the mouse is lower that its abdo-
men. Your other hand should now be free again ( see   Note 22 ).   

   16.    Pick up the syringe and gently insert it into the lower right 
quadrant of the abdomen at an approximately 30-degree angle 
( see   Note 23 ).   

   17.    Pushing down on the plunger, inject the required amount of 
tamoxifen ( see   Notes 24 – 27 ).   

   18.    Pull back the syringe. Dispose of it immediately if you are done 
injecting and a sharps container is within reach. Alternatively, 
put down the syringe and dispose of it in a sharps container 
after you have fi nished injecting all mice and the animals have 
been returned to the cage ( see   Note 28 ).      

       1.    In the fi rst few days after administering tamoxifen, check on 
the mice regularly to ensure there are no ill side effects of 
tamoxifen administration.   

   2.    Wait for the desired amount of trace time to pass ( see   Note 29 ). 
If required, set up timed-matings to trace the contribution of 
your cell population of interest to alveoli formation during 
pregnancy.      

         1.    Transfer the mouse to a euthanasia chamber.   
   2.    Start the fl ow of CO 2  to euthanize the animal ( see   Note 30 ).   
   3.    Confi rm that the animal is dead.   
   4.    Spray the mouse with 70 % ethanol and pin it to a dissection pad.   
   5.    Cut off a piece of tail and store it in an Eppendorf tube at −20 °C 

to confi rm the genotype of the animal by PCR at a later time 
point.   

   6.    Remove the mammary glands as shown in Fig.  4 , working as 
described in  steps 7 – 18  ( see   Note 31 ).    

   7.    Using a pair of forceps to hold the skin, make an incision along 
the ventral midline with a pair of sharp scissors. The mammary 
glands are located outside the peritoneum, so try to leave it 
intact when you cut open the skin.   

   8.    Moving from the midline towards the hind limb, make an 
 incision between the fourth and the fi fth mammary gland. This 
should result in an incision that is at an approximate 45-degree 
angle to the incision along the ventral midline made in  step 7 . 
Be careful not to cut any blood vessels.   

   9.    Moving from the midline towards the front limb, make 
another incision at a 45-degree angle to the incision along 
the ventral midline. Be careful not to cut any blood vessels 
( see   Note 32 ).   

3.2  Tracing

3.3  Analyzing 
the Trace Experiment 
by Whole-Mount 
Confocal Microscopy
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   10.    Using one pair of fi ne forceps to hold the peritoneum and a 
second pair of fi ne forceps to grab the skin, peel the skin fl ap in 
between the upper and lower incisions away from the 
 peritoneum and pin it down to the dissection pad. The third 
and the fourth mammary glands should now be exposed.   

   11.    Repeat  steps 7 – 10  on the contralateral side.   
   12.    Using one hand to grab the most distal tip (i.e., closest to the 

spine) of the fourth mammary gland with a pair of fi ne 
(or Dumont no. 5) forceps.   

  Fig. 4    Isolation    of the third and fourth mammary gland as described in Subheading  3.3 ,  steps 1 – 18 . ( a ) Image 
showing the secured animal on a dissecting pad, as described in  step 4 . ( b ) Image showing that both the third 
and the fourth mammary gland ( arrows ) can be easily accessed after following  steps 7 – 10 . ( c ) Image showing 
how to remove the fourth mammary gland by following  steps 12 – 14 . ( d ) Image showing the skin after both 
the third and the fourth mammary gland have been removed. ( e – f ) Image showing the third ( e ) and the fourth 
( f ) mammary gland after isolation and transfer to a piece of 3 mm Whatman paper       
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   13.    Holding a pair of scissors in your opposite hand, gently cut 
away the fi ne connective tissue that attaches the mammary 
gland to the skin, starting at the distal tip and progressing 
towards the nipple.   

   14.    As you cut away the connective tissue, gently pull the mam-
mary gland upwards.   

   15.    Cut off the mammary gland close to the nipple.   
   16.    Position the mammary gland on a piece of 3 mm Whatman 

paper and use a pair of Dumont no. 5 forceps to stretch it out 
as well as possible ( see   Note 33 ).   

   17.    Repeat  steps 12 – 16  for the fourth mammary glad on the con-
tralateral side.   

   18.    Remove the third pair of mammary glands in a similar fashion 
( see   Note 34 ).   

   19.    Process the mammary glands for whole-mount confocal micros-
copy as shown in Fig.  5 , working as described in  steps 20 – 34 .    

   20.    Transfer the pieces of Whatman paper with the mammary glands 
to a vial with 10 % neutral buffered formalin ( see   Note 35 ).   

   21.    Wrap the vial in aluminum foil and fi x the mammary glands by 
incubating them on a nutator or tube roller for up to 1 h at 
room temperature ( see   Note 36 ).   

   22.    Peel away the pieces of Whatman paper and replace the forma-
lin solution with PBS.   

   23.    Incubate on a nutator or tube roller for 15 min at room tem-
perature ( see   Note 37 ).   

   24.    Replace the PBS solution with 30 % ethanol and incubate on a 
nutator or tube roller for 15 min at room temperature.   

   25.    Replace the 30 % ethanol solution with 50 % ethanol and 
incubate on a nutator or tube roller for 15 min at room 
temperature.   

   26.    Replace the 50 % ethanol solution with 70 % ethanol and incubate 
on a nutator or tube roller for 15 min at room temperature.   

   27.    Replace the 70 % ethanol solution with 100 % ethanol and 
incubate on a nutator or tube roller for 15 min at room 
temperature.   

   28.    Replace with fresh 100 % ethanol and incubate on a nutator or 
tube roller for another hour at room temperature ( see   Note 38 ).   

   29.    Transfer the mammary glands to a fresh vial with methylsalicy-
late, cover it in aluminum foil and incubate on a nutator or 
tube roller for up to 1 h, or until the mammary glands are suf-
fi ciently cleared ( see   Note 39 ).   

   30.    Use a pair of fi ne forceps to lift the cleared mammary glands 
from the vial.   
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  Fig. 5    Processing the mammary glands for confocal microscopy as described in Subheading  3.3 ,  steps 19 – 33 . 
( a ) Image showing the isolated mammary glands in a glass vial with formalin fi xation solution. ( b ) Image show-
ing the mammary glands after fi xation, prior to clearing. ( c ) Image showing cleared mammary glands following 
fi xation, dehydration, and incubation in methylsalicylate. ( d ) Image showing a 14 mm concave microscope 
slide. ( e ) Same as in ( d ) with a trimmed piece of cleared mammary gland tissue. ( f ) Same as in ( e ) with a 
coverslip positioned onto the specimen. ( g ) Same as in ( f ) after carefully exerting pressure on the coverslip to 
fl atten the tissue, while simultaneously removing excess methylsalycilate       
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   31.    Using a pair of scissors, cut a piece that will fi t in the opening 
of a concave microscope slide ( see   Note 40 ).   

   32.    Position the piece in the middle of the 14 mm diameter circle 
and add a drop of methylsalicylate from the incubation vial.   

   33.    Cover the mammary gland with a coverslip and (wearing 
gloves) gently press down on the coverslip to fl atten the tissue 
and remove excess methylsalicylate.   

   34.    Wipe away the excess methylsalicylate with a Kleenex tissue 
( see   Note 41 ).   

   35.    Seal the coverslip with nail polish.   
   36.    Let the nail polish dry completely before taking your samples 

to the confocal microscope ( see   Note 42 ).   
   37.    Mount the slide on the stage of the confocal microscope.   
   38.    Use a 488 nm laser line to excite the membrane-bound GFP 

and a 568 laser line to excite the membrane-bound dTomato 
( see   Note 43 ).   

   39.    Image the endogenous fl uorescence signal using a 20x/0.7NA 
objective. If applicable, record a Z-stack ( see   Note 44 ).   

   40.    When you are done, remove your slide from the microscope 
stage and switch off the microscope (the following  steps 41 – 46  
are optional).   

   41.    To process the cleared glands for paraffi n embedding, remove 
the coverslip from the microscope slide using a bit of acetone 
and a Kleenex tissue.   

   42.    Transfer the mammary gland to a glass vial with molten 
paraffi n.   

   43.    Incubate in a hybridization oven at 60 °C for 1 h.   
   44.    Refresh the paraffi n.   
   45.    Incubate overnight in a hybridization oven at 60 °C.   
   46.    Embed the mammary gland in a tissue cassette for future paraf-

fi n sectioning ( see   Note 45 ).      

       1.    Download Fiji software from   http://fi ji.sc/Fiji     and install the 
software on your computer.   

   2.    Import the source fi les from your confocal microscopy 
 experiment and visualize your Z-stack with Image 5D 
( see   Notes 46  and  47 ).   

   3.    Select ‘Color’ and assign colors to each of your channels.   
   4.    If required, select Image → Adjust → Brightness/Contrast 

and adjust the sliders to improve the signal to noise ratio 
( see   Note 48 ).   

   5.    Select Plugin → Image 5D → Image 5D stack to RGB.   

3.4  Constructing 
a 3D Picture 
of Labeled Alveoli 
Using Fiji
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   6.    To make a three-dimensional reconstruction, follow  steps 8 – 11 .   
   7.    To make a maximum projection, follow  steps 12 – 14 .   
   8.    Make sure the RGB stack window is selected.   
   9.    From the menu select Plugins → 3D viewer and press ‘OK’.   
   10.    Make sure the ImageJ 3D viewer window is selected.   
   11.    From the menu, select View → Record 360 degrees rotation.   
   12.    Make sure the RGB stack window is selected.   
   13.    From the menu select Image → Stacks → Z-project.   
   14.    Choose the appropriate projection (usual Maximum Intensity 

or Average Intensity will be the right option) and press ‘OK’.       

4    Notes 

     1.    Another approach would be to use FLP/FRT technology. 
However, the number of available mouse strains based on 
Cre/lox technology far exceeds the collection of existing FLP/
FRT lines.   

   2.    Most available Cre drivers are conventional transgenic lines, 
meaning that the transgene cassette (comprising the Cre 
recombinase gene and the selected promoter and enhancer 
sequences driving its expression) has randomly integrated into 
the genome. As a result, Cre expression is unlikely to com-
pletely recapitulate the expression pattern of the original gene 
from which the promoter and enhancer sequences are derived. 
In addition, it is important to realize that not all strains with 
the same name carry an identical transgene insertion as indi-
vidual founder lines or independent transgenic constructs may 
have been shared within the scientifi c community. Cre knock-
 in alleles, in which the Cre recombinase is targeted to the 
locus of interest, are more likely to faithfully recapitulate the 
endogenous gene expression pattern. Regardless, it is recom-
mended that investigators do not solely rely on the published 
literature describing the Cre expression pattern. Few if any 
lines have been exhaustively characterized and ideally, Cre 
activity in each line should be carefully assessed in both spatial 
and  temporal terms prior to commencing the actual lineage 
tracing experiment.   

   3.    When using a straight (i.e., non-inducible) Cre allele, the fi rst 
cells to express the recombinase will be labeled. For instance, 
K14-Cre fi rst becomes active in the developing embryo. This 
results in labeling of K14 +  cells in the embryonic mammary 
bud and precludes the specifi c interrogation of K14 +  cells in 
the postnatal mammary gland. Modifi ed versions make use of 
a Cre-ER fusion gene, in which the Cre recombinase has been 
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fused to a moiety of the estrogen receptor (ER), thereby 
rendering the Cre recombinase inactive in the absence of estro-
gen analogues [ 15 ]. Later generations contain specifi c point 
mutations in the ER portion of the fusion gene (Cre ERT  [ 16 ] or 
Cre ERT2  [ 17 ,  18 ]), which greatly reduce sensitivity to circulat-
ing endogenous estrogens. This tightens the system by elimi-
nating leakiness, while simultaneously allowing the induction 
of Cre recombinase activity by the administration of the syn-
thetic estrogen analog tamoxifen.   

   4.    Alternatives to this system already exist and as the experimental 
methodologies continue to be refi ned, more will undoubtedly 
become available in the future. For instance, lineage tracing 
can also be performed using a three-component system com-
prising a tissue-specifi c rtTA driver, a tetO-Cre recombinase 
and a fl oxed reporter allele. Each system has its own advan-
tages and disadvantages, but the use of more than two alleles 
greatly complicates mouse breeding.   

   5.    Cre-inducible reporter alleles usually contain a so-called stop 
cassette, which is fl anked by loxP sites and which prevents tran-
scription of the downstream marker gene. Upon recombination 
of the reporter allele, the stop cassette is excised and the marker 
gene is expressed. Genetic recombination is irreversible. 
Therefore, the mark not only remains present for the remainder 
of the cell’s life span but it is also passed on to all of the cell’s 
offspring. It is this property that allows lineage tracing.   

   6.    A more sophisticated reporter does not necessarily represent a 
better choice. For instance, compared to  Rosa26-mTmG , the 
 Rosa26-Confetti  reporter recombines less effi ciently in the 
mammary gland. Thus, whereas the  Rosa26-mTmG  reporter 
can be used to label cells at all stages of embryonic and postna-
tal mammary gland development in combination with the 
 Axin2   CreERT2   driver, in my hands use of the  Rosa26-Confetti  
reporter is effectively limited to puberty.   

   7.    It is recommended to backcross the Cre driver and reporter 
lines to the same genetic background (usually C57/B6 or 
FVB), owing to differences in mammary gland development 
between individual mouse strains. The reporter lines listed in 
Table  1  can be maintained as a homozygous stock on a C57/
B6 background without any breeding problems. Whether the 
same holds true for the Cre driver will depend on the specifi c 
strain. I prefer to keep the Axin2 CreERT2  mice as a heterozygous 
stock on a C57/B6 background. Even though the Axin2 CreERT2  
allele is not leaky, I always maintain separate stocks of the 
driver and reporter lines, intercrossing them only as required. 
The presence of a single copy of the reporter allele is suffi -
ciently sensitive to perform lineage-tracing experiments in the 
mammary gland.   
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   8.    Tamoxifen is a structural estrogen analog and is classifi ed as a 
carcinogen. Gloves should be worn when handling and weigh-
ing the product.   

   9.    Tamoxifen is notoriously diffi cult to dissolve. Including 10 % 
ethanol helps to get the tamoxifen into solution. Instead of 
corn oil, it is also possible to dissolve the tamoxifen in oil that 
is fi t for human consumption (e.g., sunfl ower oil bought in 
the supermarket).   

   10.    Methylsalicylate (also known as oil of wintergreen) is toxic 
upon ingestion. Inhalation and contact with the skin should 
be prevented. It has a very penetrant smell and even when the 
stock bottle is opened in the fume hood it is impossible to 
prevent the smell from entering the lab. It has, however, long 
been used as a clearing agent and in my hands, after testing 
many different methods, it gives the best results for whole- 
mount confocal microscopy. The commercially available clear-
ing agent Focus Clear (Cedarlane Labs) gives good results as 
well, but it is very expensive.   

   11.    Given the cost associated with purchasing a confocal micro-
scope, the average investigator will most likely have little 
choice with respect to the equipment that is available for use. 
He/She is advised to talk to a local expert, who can help with 
the appropriate settings. In the past we used a Leica SP5 
equipped with 3 HyD detectors and 2 PMTs, which is user 
friendly and offers the benefi t of having a slider rather than 
fi xed-width bandpass fi lters. The latter is particularly useful for 
multi-color reporter (e.g.,  Rosa26-Confetti ) imaging. We are 
currently using a Nikon A1 to detect endogenous fl uorescence 
of the  Rosa26-mTmG  and the  Rosa26-Confetti  reporter alleles 
and we have also observed endogenous fl uorescence on a Carl 
Zeiss LSM510.   

   12.    As an investigator, you are both ethically and scientifi cally 
responsible. Make sure that all animal experiments are 
approved by your local animal welfare committee prior to 
starting and always adhere to the local guidelines.   

   13.    Always genotype your mice, even if you “know” what the gen-
otype is supposed to be! It is almost inevitable that at some 
point or another animals will be switched (either because they 
are put in the wrong cage, or because their mark is misread), 
especially when you are breeding large numbers of mice and/
or multiple strains. It is better to catch a mistake early on than 
after many months (or years) of crossing. I genotype the 
 Axin2-Cre   ERT2   mice using the forward primer RVA283 
(5′CGATGCAACGAGTGATGAGGTTC3′) and the reverse 
primer RVA282 (5′GCACGTTCACCGGCATCAAC3′), with 
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an annealing temperature of 58 °C and a total of 35 cycles. 
This results in a Cre-transgene specifi c product of approxi-
mately 350 base pairs. I genotype the  Rosa26-mTmG  mice 
using the three-primer PCR posted on the Jackson labs web-
site for this strain. Primers RVA284 (or oIMR7318, 5′CTC
TGCTGCCTCCTGGCTTCT3′), RVA285 (or oIMR7319, 
5′CGAGGCGGATCACAAGCAATA3′), and RVA286 (or 
oIMR7320, 5′TCAATGGGCGGGGGTCGTT3′) give a 
band of 330 base pairs for the wild-type  Rosa26  locus and a 
band of 250 base pairs for the  Rosa26-mTmG  allele. This PCR 
can also be run with an annealing temperature of 58 °C and a 
total of 35 cycles. Primers RVA284, RVA285, and RVA286 
can also be used to genotype the  Rosa26-Confetti  mice.   

   14.    It is easiest to genotype the mice around the time they are 
weaned (approximately postnatal day 21, P21) and to also give 
each of the animals a unique identifi er at this point (e.g., 
earclip). Collect a piece of tail, toe or ear tissue (according to 
local guidelines) and lyse the tissue. The easiest way to get 
DNA out, is to lyse your samples in Viagen tail lysis buffer (use 
approximately 100–200 μl per sample) supplemented with 
100 μg/ml proteinase K. Following overnight incubation at 
55 °C, inactivate the proteinase K by heating the samples to 
85 °C for 15–45 min. You can now directly use 1–10 μl the 
lysate as input for your genotyping PCR. Alternatively, you 
can follow a DNA isolation protocol that uses homemade lysis 
buffer [ 19 ]. Using the commercial lysis buffer is faster, but 
more expensive. There is no difference in the quality of the 
DNA in terms of performance in the PCR.   

   15.    This only holds for traces that are started in postnatal animals. 
If you start an embryonic trace (e.g., as outlined in Fig.  3b ) 
you can only genotype the experimental animals after they are 
born. When you initiate a trace in early postnatal animals (e.g., 
P14, but in reality anything prior to weaning), it is often 
unpractical to genotype the mice beforehand as well. In these 
cases it is advisable to set up your breeding schemes in such a 
way that your litters have a high chance of containing double- 
heterozygous mice, but remember that not all strains perform 
well as breeders when they are homozygous.   

   16.    Like any experiment, a lineage-tracing analysis should be well 
controlled. A technical positive control will usually be diffi cult 
(if not impossible) to obtain, since it would require an indepen-
dent Cre-driver that is known to work in your tissue of interest. 
If possible, use a different tissue from the double- heterozygous 
mice in which you initiate the trace as a positive control at the 
time of analysis. For instance,  Axin2-Cre   ERT2   also marks intesti-
nal stem cells. Because Cre-mediated recombination in the 
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intestine is far more effi cient than in the mammary gland, I 
often check if my experiment has worked by isolating a piece of 
intestine from tamoxifen-injected double-heterozygous    Axin2-
Cre   ERT2   ;Rosa26-mTmG  mice and quickly score that under a 
fl uorescent microscope.   

   17.    As a negative control, inject double-heterozygous  Axin2- 
Cre   ERT2         ;Rosa26-mTmG  mice with corn-oil control solution. 
This will allow you to ascertain if your Cre allele is leaky. 
Because animal numbers are often limiting, it is virtually impos-
sible to take this control along in every experiment. However, 
leakiness should ideally be tested for every Cre strain for each 
experimental protocol (i.e., breeding scheme and age of analysis) 
at least once at the outset of the experiment.   

   18.    To be sure that the fl uorescence signal you are scoring in your 
analysis is real, you can take along a littermate that does not 
carry the Cre-allele, but which is heterozygous for the  Rosa26- 
mTmG   allele. This is especially important when you are just 
getting started and still need to become familiar with the pat-
tern of clonal outgrowth that you will see and/or if you are 
analyzing the mammary gland by FACS analysis. If you are 
truly performing clonal tracing analyses (i.e., each mammary 
gland will only contain a few positive clones), the majority of 
the tissue will in fact be an intrinsic negative control and indi-
vidual (or patches of) labeled cells will be easy to identify in an 
otherwise unrecombined epithelium.   

   19.    For the correct interpretation of your tracing experiments, 
proper biological controls are essential. For instance, when you 
are studying the contribution of mammary stem cells to turn-
over of the mammary epithelium during multiple rounds of 
pregnancy, lactation and involution, be sure to trace nullipa-
rous and primiparous mice as well. Given the biological varia-
tion between individual mice, it is best to always use littermates 
of the multiparous mice you are tracing and, when the mice are 
not in a mating scheme, to house these females in the same 
cage as much as possible.   

   20.    Filter sterilizing may not always be required and most likely 
depends on the quality of the oil you use to dissolve the tamox-
ifen. When using corn oil, I always do it as a precaution, after 
experiencing problems with injecting unfi ltered corn oil at 
some point. Be careful when exerting pressure on the syringe, 
as the solutions will be very viscous.   

   21.    This protocol will assume that tamoxifen is administered by 
means of an intraperitoneal injection. Alternatively, oral gavage 
may be used. This is a matter of personal preference.   

   22.    Find out what is most comfortable. Either inject with your dom-
inant hand and hold the mouse with the other, or vice versa.   
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   23.    Injecting at a shallow angle in this quadrant minimizes the 
chance of damaging internal organs, such as the liver, small 
intestine, caecum, and bladder. If you want to make sure you 
are in the right spot, you can always aspirate a small volume 
prior to injecting. If the aspirate is green/brown, yellow, or 
red, you have penetrated the intestine, bladder, or blood ves-
sels and you should not inject. However, as long as you do not 
insert the needle too deep (i.e., up until about 0.5 cm) this 
should not be a problem.   

   24.    A tamoxifen inducible system offers experimental control over 
the onset, but also the extent of recombination. This is par-
ticularly important when the lineage-tracing experiment is 
designed to label stem cells. To be able to track clonal out-
growth, Cre-mediated recombination should be sporadic. This 
ensures that labeled cell clusters really are the clonal offspring 
of a single recombination event in an individual stem cell. 
Theoretically, each mammary gland should thus contain a sin-
gle cell clone. In practice however, it means that there should 
be suffi cient space (i.e., stretches of unlabeled tissue) between 
labeled patches of tissue. This can be achieved by lowering the 
amount of tamoxifen that is injected. I often get asked what 
the half-life of tamoxifen is following injection as it will circu-
late in the animals for some time following injection. In prac-
tice, however, it is very well possible to label even fast- dividing 
cells (e.g., in the intestinal crypt [ 6 ,  20 ] or the developing 
embryo [ 21 ]) by essentially causing a pulse of Cre-activity.   

   25.    In my experience (at least with the  Axin2-Cre   ERT2   mice), 
tamoxifen-mediated recombination in the mammary gland is 
far less effi cient than in other tissues. For instance, in the skin 
[ 22 ] and the intestine [ 6 ], which also contain Wnt-responsive 
stem cells, we can inject as little as 0.1–0.2 mg tamoxifen per 
25 g of body weight into adult mice and still score a suffi cient 
number of clones. By comparison, recombination in the mam-
mary gland requires 4 mg tamoxifen per 25 g of body weight 
in adult mice. This translates to administering 200 μl of a 
20 mg/ml tamoxifen solution into an 8–10-week-old mouse. 
The amount of tamoxifen that is to be injected will vary 
depending on the experiment (e.g., if clonal labeling is not 
required, more tamoxifen can be injected), the reporter that is 
used (e.g., using the same amount of tamoxifen, recombina-
tion is far less effi cient in  Axin2-Cre   ERT2   ;Rosa26-mTmG  mice 
than in  Axin2-Cre   ERT2   ;Rosa26-Confetti  animals) and the Cre 
driver.   

   26.    The absolute amount of tamoxifen (as well as the total injec-
tion volume) should always be adjusted for the age and weight 
of the mice. For instance, when inducing sporadic recombina-
tion in P14 animals, I try to inject at most 1–2 mg tamoxifen 
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in a total volume of 100 μl. Injecting tamoxifen at this age can 
result in a growth defi cit. The animals will eventually catch up, 
but it may require them to stay with the mother for a bit lon-
ger. Extra care should be taken when inducing recombination 
in the developing embryo by injecting tamoxifen into preg-
nant animals. I prefer to use a low stock concentration (i.e., a 
tamoxifen solution of 2–5 mg/ml) and try to inject no more 
than 0.5 mg tamoxifen in total. Even so, the injection of 
tamoxifen into pregnant females can induce termination of the 
pregnancy and/or delivery problems. This can be avoided by 
co-injecting progesterone [ 21 ].   

   27.    Please be aware that tamoxifen is a mixed estrogen agonist/
antagonist, meaning that it can either mimic or counteract the 
effects of estrogen in different tissues. Since the mammary 
gland is particularly sensitive to estrogen, it is important to be 
aware of potential side effects. For instance, we have observed 
that even a single injection of tamoxifen prior to or during 
puberty (at concentrations below those reported in the litera-
ture) can delay mammary gland outgrowth [ 23 ]. Although the 
tissue eventually catches up, this is something to keep in mind. 
This is a downside of using tamoxifen-mediated Cre/lox 
recombination for lineage-tracing experiments in the mam-
mary gland, but at present this remains the most fl exible, infor-
mative and widely used system of choice.   

   28.    Never recap a used needle.   
   29.    To interpret the outcome of a long-term tracing experiment, it 

is advisable to collect samples at (i.e., set up dedicated tracing 
experiments for) various time points along the way. First, you 
will always want to determine which cells fi rst recombine the 
reporter allele (i.e., your starting population) by  performing a 
short term tracing experiment. The  Rosa26-lacZ  reporter will 
allow you to analyze the mammary gland as early as 24 h after 
tamoxifen administration, whereas the GFP signal in the 
 Rosa26-mTmG  cannot be detected robustly until 48 h after 
tamoxifen administration. Second, if you are interested in trac-
ing stem cells, it is important to note that (even when you are 
using a driver that is known to label stem cells, such as  Axin2- 
Cre   ERT2       ) not all labeled cells are indeed stem cells. To qualify as 
a stem cell, a cell needs to meet two criteria: It has to give rise 
to differentiated offspring and it has to survive turnover of the 
tissue. The only way to be sure that the mammary epithelium 
has completely turned over is by tracing cells through a com-
plete round of pregnancy, lactation and involution. Here too, 
it will be helpful to have some analytical time points along the 
way (e.g., prior to pregnancy, mid-pregnancy, mid- lactation, 
mid-involution, post-involution).   
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   30.    Please follow the local guidelines for euthanizing animals.   
   31.    There are many ways in which a lineage tracing experiment can 

be analyzed. This includes FACS analysis, but also various his-
tological analyses. The remainder of the protocol will describe 
analysis by whole-mount confocal analysis, which allows 3D 
reconstruction of labeled structures.   

   32.    Accidentally hitting a blood vessel is more likely to occur near 
the front limbs than near the hind limbs. Try to prevent it by 
not cutting too far away from the midline.   

   33.    The idea is to fi x the mammary gland in such a way that it stays 
fl at. Another way to achieve this is by stretching the mammary 
gland on a glass slide, covering it with a second glass slide and 
fi xing this “sandwich” in a 50 ml Falcon tube. This works well, 
but uses a lot more formalin.   

   34.    The boundaries of the third mammary gland are not as well 
defi ned as the fourth mammary gland, so isolating it may feel 
a bit intuitive at fi rst. It is closely associated with the fi rst and 
second mammary gland. In addition, there is a high chance of 
collecting some muscle tissue and of hitting blood vessels, 
both of which may obscure a whole-mount preparation. On 
the up side, the third mammary gland is a lot fl atter than the 
fourth, which helps for whole-mount confocal microscopy.   

   35.    You can use glass scintillation counter vials that hold up to 
25 ml for processing multiple glands together, or smaller snap 
cap glass vials that hold up to 4 ml for processing an individual 
gland.   

   36.    As little as 15 min may be enough. In fact, if you are interested 
in analyzing the  Rosa26-mTmG  reporter by whole-mount con-
focal microscopy, you can omit the formalin fi xation step alto-
gether and transfer the isolated mammary glands directly to 
100 % ethanol. Because the GFP and dTomato are membrane 
bound, their signal will be preserved. Importantly, this will not 
work for the  Rosa26-Confetti  reporter, which does require for-
malin fi xation. Therefore, it is safest to include this step for all 
fl uorescent reporters.   

   37.    Formalin should be disposed of as toxic waste. Please follow 
local guidelines.   

   38.    It is important that the tissue is completely dehydrated prior to 
transfer into methylsalicylate, otherwise the clearing will not work.   

   39.    Use approximately 5 ml per mammary gland. Provided that 
the mammary glands are properly dehydrated, clearing will 
become apparent within 15 min.   

   40.    For the third mammary gland it is often suffi cient to trim the 
edges. For the fourth mammary gland, I usually cut straight 
through the lymph node. This separates the proximal from the 
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distal portion of the gland and still allows the lymph node to 
be used for orientation. After this, trim the edges of the fat pad 
and remove excess pieces of tissue from the top or bottom.   

   41.    At this point, there should be a continuous ring of methyl-
salicylate surrounding the concave opening. If you see any air 
pockets, this means the specimen either needs to be fl attened 
further or is too thick. In the latter case, you can remove the 
tissue and use pair of scissors to trim it until it does fi t. The 
entire dimple holding the tissue does not need to be fi lled with 
methylsalicylate, but to prevent the tissue from drying out, it is 
best to only mount the specimen immediately prior to micro-
scopic analysis.   

   42.    At this point, I usually dry the slides in the dark (i.e., in a 
drawer). There is no need to switch off the overhead lights 
during any of the previous steps. The fl uorescent signal will 
not be quenched.   

   43.    For the  Rosa26-Confetti , use 458 nm (for CFP), 488 nm 
(GFP), 514 nm (YFP), and 561 nm (RFP) laser lines.   

   44.    This is the most diffi cult part of the procedure. It takes time 
and patience to get a feel for the appearance of the whole- 
mount tissue under the microscope. I usually scan the tissue 
through the eyepiece, using a UV lamp and a GFP fi lter. With 
the  Rosa26-mTmG  reporter, this gives you just enough cell 
outlines to see where you are in the tissue. Using the focus 
knob to move up and down, you will be able to discern epithe-
lial branches and blood vessels surrounded by adipocytes. After 
a while, you will be able to identify GFP-positive cell clusters 
based on their increased intensity. Finding labeled cells with 
the  Rosa26-Confetti  reporter takes more effort, because you 
no longer have the information of the cell outlines provided by 
the membrane-bound dTomato, but can be done as well. 
Using a 20x/0.7 NA objective should give you enough work-
ing distance to make a Z-stack through an entire alveolar clus-
ter as shown in Fig.  6 .    

   45.    The described protocol is compatible with paraffi n embedding 
of the cleared mammary glands. The same labeled cell clusters 
can thus be imaged as whole mounts and on tissue sections in 
combination with other markers. During the processing for 
paraffi n embedding, the dTomato signal is always lost. This 
frees up a channel for co-staining with antibodies directed 
against structural markers. Sometimes, the GFP signal will be 
preserved, but it is advisable to detect recombined cells with an 
anti-GFP antibody (I like the Abcam chicken-anti-GFP, 
ab13790). The downside of using methylsalicylate cleared sam-
ples for paraffi n embedding is that it precludes heat- induced 
epitope retrieval (HIER) as the tissue tends to come off the 
slide. However, on paraffi n sections from  Rosa26- mTmG   
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mammary gland samples that are processed for whole- mount 
confocal microscopy with methylsalicylate but without includ-
ing the formalin fi xation step ( see   Note 36 ), you can often use 
antibodies that would normally require HIER on regular for-
malin-fi xed paraffi n-embedded sections (including the anti-
GFP antibody mentioned above). You should test which 
conditions are optimal for your antibodies. Alternatively, you 
can always process one mammary gland for whole- mount con-
focal microscopy and the contralateral gland for formalin fi xa-
tion and paraffi n embedding, thus allowing HIER and 
colocalization studies by confocal microscopy.   

   46.    When using a Leica SP5 confocal microscope, you can simply 
drag the *.lif fi le into the Fiji toolbar. You will then be pre-
sented with the option to ‘View as Image 5D’. Choose this 
option. For other microscopes, the images may open as a stack. 
In that case, select Plugin → Image 5D → Stack to Image 5D 
and proceed as described.   

   47.    If you happen to only be able to import individual *.tif fi les, 
wait for all the fi les in your stack to import. Then select Image 
→ Stacks → Images to Stacks. Make sure the resulting stack is 
selected and choose Image → Hyperstacks → Stacks to 
Hyperstacks. Assign the correct number of channels (c) and 
sections (z). For Display Mode select ‘Color’. Make sure that 
the resulting hyperstack is selected and choose Plugins → 
Image 5D → Stack to Image 5D and proceed as described.   

   48.    Be careful when adjusting the sliders and try to prevent image 
adjustments as much as possible.         

  Fig. 6    Whole-mount confocal microscopy images after processing in Image J. ( a ) Maximum Z-projection of a 
whole-mount  Axin2-CreERT2;Rosa26-mTmG  mammary gland showing recombined (mG,  green ) and unre-
combined (mT,  red ) cells (168 slices, imaged on a Leica SP5 confocal microscope using a 20x/0.7NA objec-
tive). For this particular experiment, the trace was initiated at E13.5 and the mammary glands were isolated at 
P8. Prior to puberty, the ductal network is small and an entire epithelial tree fi ts into the frame of view when 
using a 20× objective. ( b ) Snapshots from a movie showing the 3D rotation of a reconstructed alveolar cluster 
of a whole- mount  Axin2-CreERT2;Rosa26-Confetti  mammary gland demonstrating the clonal outgrowth of 
recombined (CFP,  blue ) cells (107 slices, 1024 × 1024 pixels, imaged on a Leica SP5 confocal microscope 
using a 20x/0.7NA objective and a 4× zoom). For this particular experiment, the trace was initiated at P42 and 
the mammary glands were isolated at E14.5 of the fi rst pregnancy       
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